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CAS2Net and CCAS 
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19 September 2024

1:00 PM Eastern Time

Topic: 
EOY CAS2Net and CCAS Spreadsheet Enhancements
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TEAMS Meeting Link      Meeting Call in Information
Meeting ID: 231 024 528 524                       +1 571-403-9146 
Passcode: SMZdLr                  Phone Conference ID: 989 870 18# 

https://teams.microsoft.com/l/meetup-join/19%3ameeting_YWRjYWYyN2EtNzgyMy00ZWE2LWE2YTMtZmYyOTkxNTA1YzU3%40thread.v2/0?context=%7b%22Tid%22%3a%221c21be44-2435-49bf-bc1f-cba317187058%22%2c%22Oid%22%3a%22ad5815de-5095-4600-8a86-0164be9d07a8%22%7d
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Housekeeping Items 
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Open Forum slides are sent in advance through 
1. CAS2Net Pay Pool Notices
2. CAS2Net What’s New
3. CAS2Net User Notifications

If you did not receive/see it,                                                                                               
enter your email address in                                                                                                  
the TEAMS chat.                                                                                        

Please remember to “Mute” your phone to prevent any background noise and 
additional feedback.
All Open Forum Sessions will be recorded.
Each recorded session will be posted to the AcqDemo website (including presentation 
slides) at https://acqdemo.hci.mil/training.html#cas2netOpenForums. 

https://acqdemo.hci.mil/training.html#cas2netOpenForums
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Weekly Open Forum 

 
3

 12 September, 1pm – 2:30pm ET: Transfer, Archive and Post Cycle Activities
 19 September, 1pm-2:30pm ET: Changes in Sub-Panel Meeting and CMS 
o 26 September, 1pm-2:30pm ET: Macro Free Sub Panel Spreadsheet and Macro 

Free CMS
o 03 October, 1pm-2:30pm ET: Discrepancy Reports
o 10 October, 1pm-2:30pm ET: Lock/Unlock Supervisor 1, Sub-Pay Pool and Pay Pool
o 17 October, 1pm-2:30pm ET: Pay Pool Analysis Tool (PAT)
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AcqDemo Tools and Processes

CAS2Net Enhancements
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CAS2Net - Supervisor/Team Leader Cash Differential
CAS2Net > Organization Management > Organization Details > NEW Use 
Differential Percent to add ability to edit supervisor differential based on 
dollar or percentage amounts
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Upcoming release to CAS2Net Production

NEW
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CAS2Net User Profile … Post Cycle Activity
CAS2Net > Administrator > User Management > User Profile 
• Added Post Cycle Activity

– Death of Employee
– LWOP
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CAS2Net > Macro-Free CMS/Subpanel Interface
Download Macro-Free Sub-Panel Meeting Spreadsheet and upload

Download Macro-Free CMS and upload

26 Sep 2024 Open Forum
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AcqDemo Tools and Processes 
Spreadsheet Enhancements

Macro-Enabled CMS
Macro-Enabled Sub Panel 

16
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Major Enhancements for the Coming Cycle
• CMS 

– Added supervisor differential situation column consisting of three 
possible situations
• 1 for Organizational level and scope, difficulty, and value of position
• 2 for Extremely difficult to fill
• 3 for Salary inequities may exist

– Added ability to import/edit supervisor differential based on dollar or 
percentage amounts

– Allowed control point OCS values to have 4 significant digits to increase 
accuracy

– Moved New Cycle Expected OCS to summary column areas on Data 
Sheet

– Added Command Code (Sub-Agency) column to Data sheet

• Sub-Panel
– Allowed control point OCS values to have 4 significant digits to increase 

accuracy
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CMS Enhancements – Differential Situations
Added supervisor differential situation column consisting of three possible 
situations
• NEW Supervisor Differential Situation Column CV choose situation for the 

Supervisor and Team Leader Cash Differential

11

Documentation required for the AcqDemo Supervisor and Team Leader Cash Differential

Chapter 5.21.3.1 To request a supervisory or team leader cash differential, a request package is initiated by the immediate supervisor, coordinated with 
the servicing HR Specialist, and approved/disapprove by a higher-level supervisor, manager, or equivalent as determined by the Participating 
Organization’s business rules. The approval authority may also be assigned to the Pay Pool Manager/Panel or Personnel Policy Board. The request package 
contain a memorandum from the supervisor or nominating official that describes the circumstances supporting the request, affirms that funds are 
available, and documents the approval process. A sample memorandum is provided at Appendix A, Chapter 5. The package must also include a current 
organization chart and a comparison of the employee’s current basic pay of his/her position’s broadband level, and any applicable control point/maximum 
OCS or internal broadband level pay range within the broadband level, and if applicable, the pay of the employees under the supervisor/team leader.  

Once approved, the employee must sign a statement of understanding as shown at Appendix B, Chapter 5.
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CMS Enhancements – Differential $ or %
Import/Edit Supervisor Differential based on $ or %

The Data Administrator sets in CAS2Net Organization 
Details > Use Differential Percent either for dollar or 
percent. That will specify whether the Supervisor 
Differential will be imported into the CMS as a dollar or 
a percent. 

• If Use Differential Percent is set to Yes (use %) in CAS2Net,                              
Column CZ will allow entry of values and the $ will be calculated. 

• The new rates will be in Column DA New Supervisor Differential Rate.
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CMS Enhancements - Four (4) Decimal Places 
Allowing up to Four (4) Decimal Places for the OCS Control Point 
• In Column CN, for the OCS Control Point, the values can now have up to 

four (4) decimal places

• These additional decimal places allow for increased precision
• This enhancement was also coded into the Sub-Panel Meeting Spreadsheet

13
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CMS Enhancements - Four (4) Decimal Places 
Example - Four (4) Decimal Places for the OCS Control Point 
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CMS Enhancements - Four (4) Decimal Places 

IAW business rule, (1) adjust OCS Control Points to four decimal places and 
(2) use Discretionary CRI to attain maximum pay of the broadband level 
(3) Column CT New Basic Pay 2025 = (4) Column BH CY2025 Max for BB&CP

15

1

2 34
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CMS Enhancements – Control Point $

IAW business rule, (1) adjust Control Point $ to desired basic pay (2) adjusted Control 
Point Used in Calculations, (3) use Discretionary CRI to attain desired basic pay at 
maximum of the broadband level, (4) Column CT New Basic Pay 2025 = (5) Column 
BH CY2025 Max for BB&CP

16

1

1 23 45
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CMS – Override CRI

17

For red highlighted cells in 
Column CP and to override 
the Approved CRI and if 
Control point Used in 
Calculation is correct
• Rollover CRI to CA CRI 

change from 1 to 0 = 
Computed CRI becomes 
Approved CRI up to new 
max for BB&CP, remainder 
does not become a 
Carryover Award

• Rollover CRI to CA CRI 
change from 1 to 2 = 
Computed CRI becomes 
Carryover Award

• Override CRI – change 0 to 
1 = no Approved CRI and 
no Carryover Award



http:/acqdemo.hci.mil

AcqDemo - Across the Board Basic Pay Increase
Federal Register, page 52129, Section 
II.D.2.d.(2)(c)1—General Pay Increase (GPI). The 
GPI is the across-the-board basic pay increase 
authorized by law or the President for the GS 
under 5 U.S.C. 5303. The funds allocated for the 
GPI that are not awarded may be transferred to 
either the CRI Fund or the Contribution Award 
(CA) Fund or divided among them barring any 
higher authority restrictions. 

Employee’s basic pay * 1.7%
AcqDemo Basic Pay Tables are linked to the 
General Schedule base salary table

18

The across-the-board basic pay raise for 2025 depends on the issuance of the President’s 
Executive Order on Adjustments of Certain Rates of Pay and its subsequent publication 
by OPM, which is anticipated in mid-to-late December 2024.
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AcqDemo - Across the Board Basic Pay Increase
AcqDemo Basic Pay Tables are linked to the General Schedule base salary 
table
• GS-1/Step1 to GS-4/10  NH-1
• GS-5/Step1 to GS-11/10  NH-2
• GS-12/Step1 to GS-13/10  NH-3
• GS-14/Step1 to GS-15/10  NH-4
• GS-1/Step1 to GS-4/10  NJ-1
• GS-5/Step1 to GS-8/10  NJ-2
• GS-9/Step1 to GS-11/10  NJ-3
• GS-12/Step1 to GS-13/10  NJ-4
• GS-1/Step1 to GS-4/10  NK-1
• GS-5/Step1 to GS-7/10  NK-2
• GS-8/Step1 to GS-10/10  NK-3
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AcqDemo - Across the Board Basic Pay Increase
Federal Register, page 52133, Section II.D.3.c.(1) SPL. The SPL begins at an 
OCS of zero and the basic pay of a GS–1, Step 1, and terminates at an OCS of 
100 and the basic pay of a GS–15, Step 10.  
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AcqDemo - Across the Board Basic Pay Increase
After the CY2025 across-the-board basic pay increase, NH/NJ/NK-1, NJ/NK-2, 
and NH-4 who were at the maximum basic pay of their career path  and 
broadband level in CY2024 are no longer at the max for broadband and career 
path in CY2025

21
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AcqDemo - Across the Board Basic Pay Increase
Example
(1) Column P Employee’s CY2024 Basic Pay at maximum of the broadband 

level for the career path
(2) Column BN CY2025 Max for BB&CP
(3) Across the Board basic pay increase Column P CY2024 Basic Pay *1.7% 

GPI = Column BX Pay with GPI
(4) Column CT for NH/NJ/NK-1, NJ/NK-2, and NH-4 who were but no longer 

at the maximum for career path and broadband

22

1 2 3 4
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AcqDemo - Across the Board Basic Pay Increase
Option when IAW business rule, use Discretionary CRI to maintain employees 
who were at the maximum basic pay for their career path and broadband
(1) Column P Employee’s CY2024 Basic Pay at maximum of the broadband level for the career path
(2) Column BN CY2025 Max for BB&CP
(3) Across the Board basic pay increase Column P CY2024 Basic Pay *1.7% GPI = Column BX Pay with GPI
(4) Column CT for NH/NJ/NK-1, NJ/NK-2, and NH-4 who were but no longer at the maximum for career path 

and broadband

(5) Use Discretionary CRI
(6) Column CT New Basic Pay 2025 = Column BN CY2025 Max for BB&CP

23

1 2 3 65
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CMS Enhancements - CA Award > $10K 
• Revised CA Award > $10K ICW Federal Register Table 6, Footnote 10

• If Computed Award + PPM Input Discretionary Award + Second 
Discretionary Award = Final CA Award > $10,000, require approval above 
the Manager
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Added Command Code Column to Data Sheet
• In Column EG, there is a new “Command Code” (Sub-Agency Code) field 
• This value is not editable in the CMS and needs to be set in CAS2Net (auto-

populated bi-weekly from DCPDS file)

CMS Enhancements - Command Code

25
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CMS Enhancements -New Cycle Expected OCS 
New Cycle Expected OCS included in Data > Compensation Summary
• The CY2025 Expected OCS is now built into the Compensation Summary 

fields in Column EP
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CAS2Net and CCAS End of Cycle
• Tuesday 1 October 2024

o End of Cycle Modules
 Appraisal Status
 Offline Interface
 Previous Cycle Data
 Sub-Panel Meeting
 CMS Online
Macro-Free CMS/Subpanel Interface

o Pay Pool Notices
 2024 Sub-Panel Meeting Spreadsheet* 
 2024 Compensation Management Spreadsheet (CMS)*
 2024 Pay Pool Analysis Tool (PPAT)*

o AcqDemo web site
 2024 Sub-Panel Spreadsheet User Guide
 2024 CMS User Guide
 2024 PAT User Guide

27
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System Check
Macro-Enabled Sub-Panel Meeting Spreadsheet, Macro-Enabled CMS, and 
Macro-Enabled Pay Pool Analysis Tool (PPAT)
• Digitally signed version 

– 2024 Sub-Panel Meeting Spreadsheet v1signed.xlsm
– 2024 CMS v1signed.xlsm
– 2024 Pay Pool Analysis Tool v1signed.xlsm

• Unsigned version (previous years) 
– 2024 Sub-Panel Meeting Spreadsheet v1.xlsm
– 2024 CMS v1.xlsm
– 2024 Pay Pool Analysis Tool v1.xlsm

Excel > File > More > Options > Trust Center > Trust Center Setting > Macros Settings

Macro-Free Sub-Panel Meeting Spreadsheet and Macro-Free CMS
• Must have Excel for Microsoft 365, Excel for Microsoft 365 for Mac, Excel 

for the web, Excel 2021, Excel 2021 for Mac or newer
Excel > File > More > Account 

28
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End of Cycle Key Dates
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DCMA  6 Dec 2024
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2024 Open Forum Schedule
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 04 January, 1pm – 2:30pm ET: CCAS Pay Transactions for Regional Pay Offices
 01 February, 1pm – 2:30pm ET: CCAS Grievance and Archive/Transfer
 07 March, 1pm – 2:30pm ET: Assigning Mandatory Objectives, Mid-Point Review, Additional 

Feedback, and Closeout Assessment
 04 April, 1pm – 2:30pm ET: Communicating with AcqDemo Program Office on CAS2Net and 

CCAS Issues 
 02 May, 1pm – 2:30pm ET: Reports – FY-based Reports & Current Settings Reports 
 06 June, 1pm – 2:30pm ET: Macro Free Sub Panel Spreadsheet and Compensation 

Management Spreadsheet (CMS) Introduction
 11 July, 1pm – 2:30pm ET: Creating Sub-Organization Levels and Assigning Sub-Panel 

Managers, and User Role Assignments
 01 August, 1pm – 2:30pm ET: CCAS Spreadsheet Test Schedule (Offline Sub-Panel Meeting 

Spreadsheet, Offline CMS, Macro Free versions, and CAS2Net Online versions)
 05 September, 1pm – 2:30pm ET: Post Cycle Modules (Appraisal Status, Offline Interface, 

Previous Cycle Data, Sub-Panel Meeting and CMS Online)
 12 September, 1pm – 2:30pm ET: Transfer, Archive and Post Cycle Activities
 19 September, 1pm-2:30pm ET: Changes in Sub-Panel Meeting and CMS 
o 26 September, 1pm-2:30pm ET: Macro Free Sub Panel Spreadsheet and Macro Free CMS
o 03 October, 1pm-2:30pm ET: Discrepancy Reports
o 10 October, 1pm-2:30pm ET: Lock/Unlock Supervisor 1, Sub-Pay Pool and Pay Pool
o 17 October, 1pm-2:30pm ET: Pay Pool Analysis Tool (PAT)
o 07 November, 1pm-2:30pm ET: Initial and Final Upload 
o 21 November, 1pm-2:30pm ET: Not Final Reports and Data Complete Reports
o 05 December, 1pm-2:30pm ET: Grievance/Grievance Window
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Open Forum
Questions?
AcqDemo.Contact@dau.edu  

Erin.Murray@dau.edu 
jerry.lee@dau.edu 
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